
Unit 1: Programming Guide

Overview
The purpose of this unit is to introduce students to the LabVIEW™ for LEGO® MINDSTORMS® programming language and LEGO 
MINDSTORMS robotics. This guide describes how to create a program using LabVIEW for LEGO MINDSTORMS software and how 
to operate and upload programs onto the NXT Brick. It also describes some NXT functions in LabVIEW for LEGO MINDSTORMS 
software, such as the Motor Control and Wait For functions. Students will create, deploy, and test programs on the robots that 
have been created.

At the end of this lesson, students should be able to:

• Create a new Robot Project targeted to the NXT Brick in LabVIEW for LEGO MINDSTORMS software.
• Connect to the NXT Brick via Bluetooth® or USB.
• Understand how the Schematic Editor works.
• Create a program using LabVIEW for LEGO MINDSTORMS software that instructs the robot to move forward and stop.
• Download programs onto the NXT Brick device.

Basics of LabVIEW for LEGO MINDSTORMS Software
LabVIEW for LEGO MINDSTORMS is a programming language like C++, Java, Visual Basic, or ROBOTC®. It is a little different from 
a traditional text-based programming language because it is entirely graphical. LabVIEW for LEGO MINDSTORMS is composed of 
blocks on the screen. These blocks are connected with wires. The blocks include functions, inputs, and outputs.

When LabVIEW for LEGO MINDSTORMS software is launched, the Getting Started window appears. Use this window to access 
various resources including online help, example programs, and discussion forums. The Getting Started window can also be used 
to open any programs that have recently been worked on. Use the Getting Started window to start working on a new program. 
Click the Create Program button shown in Figure 1. 

Figure 1. Getting Started Window

After clicking Create Program, the options Robot Project and Virtual Instruments will appear. Notice the term "VI." VI is an 
acronym for Virtual Instrument. Basically, a VI is a LabVIEW for LEGO MINDSTORMS program. Additionally, “.vi” is the file extension 
of a program when it is saved in LabVIEW for LEGO MINDSTORMS software.

In LabVIEW for LEGO MINDSTORMS software select Robot Project and click Blank Robot from the New Program screen, as 
shown in Figure 2. 
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Click Create to open the Specify Robot Project Path window where the Robot Project name and folder path can be set. Name 
the Robot Project and choose a file path. Click Create in this window to open the Robot Project Center. The Robot Project 
Center is the starting point for all LabVIEW™ for LEGO® MINDSTORMS® projects and programs. It contains links to choose which 
NXT Brick will run programs, links to specify the setup of the robot and specify motor and sensor details, as well as links to 
create new VIs that will be a part of the current robot project. It also lists the Robot Files that are a part of the project and can be 
used to manage these files. This is shown in Figure 3.

Figure 2. Creating a New Program

Figure 3. The Robot Project Center
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Choosing the NXT Brick
To specify the robot build in the Schematic Editor, we first need to look at the NXT Brick in detail.

The NXT Brick is the brain of a LEGO® MINDSTORMS® robot. It boasts a powerful 32-bit microprocessor and flash memory. It is 
shown in Figure 4.

The NXT can receive input from up to four sensors and control up to three NXT servo motors via its seven ports. It also has an 
LCD display and four buttons. The buttons are used to navigate through the NXT menus. The NXT Brick is powered by six AA 
batteries or a rechargeable battery pack.

The two gray arrow buttons are used to navigate through the NXT Brick’s menus. The orange button is used to select objects 
from the menu, and the dark gray rectangle button is used to end a program or navigate to the main menu on the NXT Brick.

Connect the computer to the NXT Brick using USB or Bluetooth®. Start by connecting one end of the USB cable to the NXT Brick 
and the other to the computer’s USB port. Next, press the orange button to turn on the NXT Brick. The first time an NXT Brick is 
connected to a computer, it is important to be patient because the operating system can take a few minutes to install the drivers. 
After the connection has been made, the operator needs to tell LabVIEW™ for LEGO MINDSTORMS software where to find the 
NXT Brick. Click the arrow below the Choose NXT option in the Robot Project Center and click Find NXT. This will open a window 
similar to the one shown in Figure 5.

Figure 4. NXT Brick

Figure 5. Finding the NXT Brick

Because the NXT Brick has already been connected via USB, it will be listed. Click it once to highlight it and click Connect to 
link it to LabVIEW for LEGO MINDSTORMS software. The window updates to show the name, battery level, and other information 
about the NXT Brick that has been connected. This is shown in Figure 6.
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If a USB connection is going to be used, then the brick is now connected. Click Close to continue. Otherwise, connect to 
the NXT Brick via Bluetooth®. Connecting a computer with the NXT Brick via Bluetooth® is more convenient than connecting 
using a USB cable because it eliminates the use of cables. To connect to the NXT Brick via Bluetooth, ensure that either the 
computer has built-in Bluetooth capabilities or that there is a USB Bluetooth adapter installed. Enable Bluetooth from the 
computer or the Bluetooth adapter.

Also ensure that Bluetooth is enabled on the NXT Brick. To do this, turn on the NXT Brick and select Bluetooth from the main 
menu, as shown in Figure 7.

Figure 7. Selecting Bluetooth from the Main Menu

Ensure that Bluetooth has been activated by selecting the On/Off icon and selecting On. After Bluetooth has been enabled, 
the NXT will return to the main menu. Ensure also that the NXT Brick’s visibility has been enabled so that the computer is 
able to seek it. To do this, go into the Bluetooth menu again, select Visibility, and then select Visible.

Now that Bluetooth has been activated on the computer and the NXT Brick, connect to the NXT Brick via Bluetooth. To 
connect to the NXT, follow a similar procedure to when connecting via USB. Click the arrow next to Choose NXT and click 
Find NXT. The same window seen earlier in Figure 5 will be displayed. This time, click Scan to search for Bluetooth devices. 
Notice that LabVIEW™ for LEGO® MINDSTORMS® will search for Bluetooth devices, as shown in Figure 8.

Figure 6. Established Connection with NXT
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After about 10-15 seconds, the NXT Brick will be found, as shown in Figure 9.

Click the name of the NXT Brick once to highlight it and then click Connect. If this is the first time this NXT Brick is 
connecting to the computer, it will prompt to enter a passkey before the NXT Brick can pair with the computer. This window 
is shown in Figure 10. 

Enter 1234 as the passkey and select OK. Then there will be a beep and a prompt to enter a passkey on the NXT Brick. 
Again, select 1234 by navigating right and left with the gray arrow buttons on the NXT Brick and selecting with the orange 
button. After entering 1234, navigate to the checkmark icon and select it with the orange button. This is shown in Figure 11.

Figure 9. NXT Found Via Bluetooth

Figure 10. Passkey Prompt

Figure 8. Searching for Bluetooth® Devices
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The Schematic Editor and the NXT Brick
To configure the program and select the robot setup, employ the Schematic Editor. The Schematic Editor can be used to specify 
the robot setup as well as test it. To do this, click Open Schematic Editor in the Robot Project Center.

The Schematic Editor is a useful tool that helps to analyze the connections that have been made and can also be used to test 
the various motors and sensors connected to the NXT Brick. It is easy to use and helps to visualize the connections.

To add a LEGO® MINDSTORMS® servo motor, which is all that will be used in this unit, click the arrow next to the Motor Port to 
which the motor has been attached. Note that LEGO MINDSTORMS motors can be added only to output Ports A, B, and C of the 
NXT Brick. This is shown in Figure 12.

Figure 12. Adding Motors in the Schematic Editor

Figure 11. Entering Passkey on the NXT Brick

After this is complete, the operating system will take a few moments to form a connection to the NXT Brick via Bluetooth®. It will 
now be possible to wirelessly compile programs onto the NXT Brick.

After the changes have been made to the Schematic Editor, click Save and then click Close. The Robot Project Center will open 
up again.
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Creating a New VI
The next logical step is to create a VI. To do this, click New VI. A drop-down menu will appear where it can be specified whether 
this VI is targeted to the NXT Brick or the computer. In most cases, the desired configuration will be for the program to be able to 
run on the NXT Brick, without the computer connected, so click VI for NXT Target. 

Enter a name for the VI, and then click Create. After this has been done, two new windows will open. One is called the front 
panel, and the other is called the block diagram. These are shown in Figure 13.

Figure 13. Front Panel (left) and Block Diagram (right)

The front panel is similar to the front panel on the NXT Brick. This is where buttons, displays, and indicators can be seen. It is the 
user interface of the program. The block diagram is where programming is performed. This is where code will go. The code tells 
the hardware what to do and when to do it. 

The items placed on the block diagram are called terminals and functions. The items placed on the front panel are called 
controls and indicators. An interesting thing to note is that if the block diagram is closed, it can be accessed again from the front 
panel. Do this by selecting the Window drop-down menu and selecting Show Block Diagram. It can also be done by pressing 
Ctrl-E. This shortcut also enables toggling back and forth between the front panel and the block diagram. Whenever the front 
panel is closed, this essentially closes the VI and prompts the user to save any changes.

Creating LabVIEWTM for LEGO® MINDSTORMS® Code Using the Block Diagram
Now that the basics of how to navigate through LabVIEW for LEGO MINDSTORMS software have been covered, it’s time to learn 
how to write code within the block diagram. Begin by writing a simple robot program that will drive forward for a certain amount 
of time and then stop.

Become familiar with the Functions palette from which the building blocks of the code will be accessed. Right-click the block 
diagram to bring up the Functions palette, and then select the NXT I/O menu. Notice that a sub-palette will be used when 
programming LEGO MINDSTORMS robots. This is shown in Figure 14.

Figure 14. NXT I/O
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Notice that two of the terminals on this function are called NXT. One is an NXT input terminal and the other is an NXT output 
terminal. In a nutshell, these NXT terminals are used to sequence items together. Notice that there is a terminal for Power and 
one for Output Port. The Output Port terminal is where the user tells the program which motor to control. The Power terminal tells 
the program the speed at which the motor should spin.

Go ahead and select the Motor Control function and place it onto the block diagram. This is shown in Figure 16.

In the Motor On menu, choose to have the motor move Forward or Reverse. There is also the Motor Off menu, where it is 
possible to choose Coast to have the motor turn off by coasting to a stop, or choose Brake to immediately stop the motor.

Most of the functions will have this type of drop-down menu, called a polymorphic selector. This is a way of saying that this 
function can work differently in different situations. Notice that as the cursor hovers over the different options in the polymorphic 
menu, the Context Help changes to different descriptions.

In this case, the desired outcome is for the robot to move forward, so leave it in its default state: Fwd. To set up the motor to 
make the robot move forward, start by creating a constant to specify its speed. To do this, right-click over the Power terminal, 
choose Create, and click Constant. Now type a number for the speed of the motor, ranging from 0 to 100. It is important to realize 
that the default speed is 75, so if a speed is not selected, LabVIEWTM for LEGO® MINDSTORMS® will automatically select the 
speed of 75. This is shown in Figure 18.

Figure 16. Motor Control

Figure 17. Polymorphic Selector Options

When selected, the Motor Control function is defaulted to moving in a forward direction. Where it says Fwd, there is also a 
selector to open a drop-down menu. Click the drop-down menu and two choices will appear: Motor On and Motor Off, as shown 
in Figure 17.

Explore some of the items in the NXT I/O sub-palette. Navigate to the Help drop-down menu, select Show Context Help, and then 
hover over these items. Use the Context Help to assist in understanding them. Alternatively, press Ctrl-H on the keyboard to bring 
up Context Help.

Hover over the Motor Control icon and notice that Context Help shows what the output and input terminals of that function do. 
This is shown in Figure 15.

Figure 15. Motor Control

OR
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Figure 18. A Selected Motor Speed

Figure 19. Port Selector

Remember that the goal of the program is to drive forward for a certain amount of time and then stop.

Now that there is a Motor On function, which will cause the robot to drive forward, the program requires a function that will wait 
for a certain amount of time. The Wait For function waits for a specified amount of time before letting the program continue. The 
Wait For function can be found under NXT I/O and by clicking Wait. This is shown in Figure 20.

When placing the block, notice that it is a polymorphic function. There are many options here as shown in Figure 21.

Figure 20. Location of Wait For

Figure 21. Wait Function's Polymorphic Selector

Now specify which motor this function is controlling. Right-click the Output Port terminal, choose Create, and click Constant. 
This creates a constant which can select between a list of options, called an enum constant. The enum constant is wired to the 
terminal, as shown in Figure 19.
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Up to now, the Create Constant option defines input parameters for functions. Not only does this option create the value, but also 
notice that it creates a line that connects the number or port selector to the function. These lines are called wires, and wires are 
used by LabVIEWTM for LEGO® MINDSTORMS® to pass data between constants, functions, inputs, and outputs.

To manually wire items, bring up the Tools palette by clicking the View menu and selecting the Tools palette. Ensure that 
automatic tool selection is enabled by clicking the LED beside the wrench and screwdriver icon at the top of the Tools palette. 
The LED will be bright green when automatic tool selection is enabled. With automatic tool selection, the mouse pointer will 
change into different tools depending on the function the mouse is hovering over.

In order to make the program run in a certain sequence, the NXT input and output terminals must be wired together sequentially. 
With automatic tool selection enabled, click the NXT output terminal of the function that must run first, click again to create a 
wire into the NXT input of the function that must run next. Repeat this process to wire its NXT output to the NXT input of the next 
function. This is done until all of the functions in the sequence are wired together, input to output, as shown in Figure 23. The 
actual code in the blocks has been erased to focus the proper sequence the code must follow in order to work for this exercise.

Deploying and Running LabVIEW™ with LEGO® MINDSTORMS® Code on the NXT Brick
Now that there is a functional program, transfer it to the NXT Brick and then run it. 

If the NXT Brick is being used for the first time for running VIs, it is essential that the correct firmware has been installed. To do 
this, select the Tools drop-down menu and click NXT Terminal. This opens a window similar to the one shown in Figure 24.

Figure 23. Wiring Together a Sequence

Figure 24. NXT Terminal

The default is Wait for Time, which waits for a certain number of seconds. Using the Context Help, create a constant to define the 
delay duration of two seconds.

After this time has elapsed, the robot should stop immediately, so introduce a Motor Brake function. First, place a Motor Control 
function into the code. Use the polymorphic selector to select the Motor Off function, and then click Brake, as shown in Figure 22.

Figure 22. Motor Brake

1.24



Unit 1: Programming Guide

If there are multiple NXT Bricks connected, select which one to sync with by using the drop-down menu at the top of this window. 
This window shows the battery level of the NXT Brick, the amount of free space in its memory, and its firmware version. The first 
time an NXT Brick is run with LabVIEWTM for LEGO® MINDSTORMS® software, the firmware should be updated by clicking Update 
Firmware. However, this should only be done when connected via USB. At the bottom of this window, notice the File Operations. 
Here it is possible to see all of the files currently on the NXT Brick. It is a good idea to delete any old or unnecessary programs 
from the NXT Brick. All of the software files are in “.rxe” format. Click the file once to highlight it and then click Delete File(s) to 
remove it. Delete only the .rxe files. Also, click Defragment to clear up some memory.

Now programs can be run on the NXT Brick. On the LabVIEW for LEGO MINDSTORMS toolbar, notice that there are three buttons 
to run a program, each of which runs the program slightly differently. These three buttons are Run, Deploy, and Debug. These 
buttons are shown in Figure 25.

The Run button compiles the program onto the NXT Brick and immediately runs it. If this button is used with the code created in 
the lesson to make the robot move forward, LabVIEW for LEGO MINDSTORMS software compiles the software onto the NXT Brick 
and the robot immediately moves forward.

The Deploy button compiles and downloads the program onto the NXT Brick but does not run it until the user chooses to run it 
using the buttons on the NXT Brick. This is very helpful if the user wishes to compile the program using USB without having it run 
immediately. For example, if the program involves the robot moving, the Run button will compile and run the program, causing 
the robot to start moving with the USB cable still attached, whereas the Deploy button will only compile the program and, when 
the USB cable has been removed, run it.

The third method for running a program is the Debug option. Essentially, Debug keeps the link between the LabVIEW for LEGO 
MINDSTORMS program on the computer and the NXT Brick. Use this to debug the program to make sure it is working properly.

By selecting either the Run button or the Deploy button, run the program and see that the robot has moved forward for a certain 
amount of time and then stopped. This marks the creation and deployment of the unit’s first robot program.

Figure 25. Running Programs
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